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Abstract
Veins are thin-walled structures inside of which a set of valves keeps blood in the body fl owing in one direction. 
The functions of veins have not yet been characterized in detail because they are regarded as simple pipes that 
carry blood to the heart. However, the functional properties of veins need to be clarifi ed. A three-dimensional (3D) 
analysis of individual vascular smooth muscle cells, which are essential for understanding the morphological 
function of blood vessels, has not yet been conducted. We attempted to elucidate how the form of smooth 
muscle cells in the venous system differs from that of the arterial system by 3D reconstruction techniques using 
scanning transmission electron microscopy (STEM). Venules and arterioles (less than 100 μm in diameter) 
were selected. The smooth muscle cells of arterioles were spindle-shaped and densely surrounded in a circular 
manner. In contrast, a small number of smooth muscle cells were scattered around venules and were not 
arranged in the circular manner observed in arterioles. 3D reconstruction techniques revealed that venule smooth 
muscle cells had multiangular short spindle shapes. This 3D reconstruction technique stereoscopically shows all 
cell and tissue structures irrespective of blood vessels only, and may signifi cantly contribute to functional and 
morphological studies on cells and tissues in the body.
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Introduction
　　Arteries and veins both have the same three distinct layers: the tunica intima/interna, tunica media, and 
tunica adventitia. The media is the middle layer of a blood vessel and is the thickest of the three tunics in 
most arteries and veins. The intima and adventitia are similar in structure and function to arteries, whereas the 
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media is markedly thinner due to signifi cantly less smooth muscle and elastic tissue. Therefore, veins do not 
have the same capacity for elastic recoil and vasoconstriction as arteries. The walls of arteries are thicker than 
those of veins in order to withstand pulsatile fl ow and higher blood pressure. As arteries become smaller, wall 
thickness gradually decreases; however, the ratio of wall thickness to lumen diameter increases. Arterioles 
are surrounded in a circular manner by spindle-shaped smooth muscle cells (Ham 1987, Saino 2002a, 2002b, 
2008, Tamagawa 2009, 2013, Okubo 2016). The activation of the biochemical cascade of vascular smooth 
muscle contraction occurs through the binding of contractile agents, such as norepinephrine, serotonin (5-
HT), adenosine triphosphate (ATP), and endothelin, to specifi c membrane receptors present in smooth muscle 
cells (Lands 1967, Starling 1975, Mark 1988, Raymond 1990, Rosendorff 1997, Raat 1998, Saino 2002a, 
2002b, Lamont 2003, Masu 2008, Okubo 2016). The relaxation of vascular smooth muscle is triggered by 
different agents produced by endothelial cells, including prostacyclin and endothelium-derived hyperpolarizing 
factor (EDHF) (Balligand 1999, Vanhoutte 2001). A large number of morphological studies have investigated 
arterioles in vivo. For example, in terminal cardiac arterioles with an outer diameter of less than 30 μm, muscle 
fi bers became branched and commonly encircle the endothelial tube. The presence of regional differences in the 
arrangement of vascular smooth muscle fi bers indicates the heterogeneity of blood fl ow at the level of cardiac 
microcirculation (Higuchi 2001).

　　On the other hand, few studies have examined veins. In clinical settings, the vein is used to collect blood 
samples and supply water or liquid in order to maintain a healthy balance. Damaged vein walls hinder the 
circulatory system, allowing blood to collect and fl ow in a backward manner when the muscles relax. Veins 
have not been the focus of research because they are regarded as a simple tube system that carries blood from 
capillaries towards the heart. However, mouse portal veins have a spiral fold that is produced by the inner layer, 
i.e. the endothelium and smooth muscles of the wall protruding into the lumen. A transient and periodic increase 
in Ca2+ concentrations occurs in longitudinal smooth muscle cells and is transmitted spirally from the intestinal 
to the hepatic side. During peristaltic movement, the contraction of smooth muscle cells is transmitted along 
the longitudinal smooth muscles of the portal vein wall toward the liver (Takahashi 2002). This does not appear 
to be a general property of veins, and it currently remains unclear whether venule smooth muscle cells react to 
vascular stimulants. When some reactions in cells with the ability to contract are examined in vivo, their own 
shapes need to be closely compared. However, the morphological characteristics of venule smooth muscles have 
not yet been elucidated in detail.

　　In the present study, we examined the form of the smooth muscle cells of venules and how they are distinct 
from arterioles, which contribute to the maintenance of blood pressure. Electron microscopy has the capacity 
to identify the intracellular microstructures used; however, transmission electron microscopy (TEM) has the 
disadvantage of the observation field of view being limited. To overcome this drawback in our bioimaging 
center, the "TEM observation method (scanning transmission electron microscopy, STEM) by a scanning 
electron microscope" was improved (Hoffpauir 2007, Ponce 2012, Sawai 2013). The 3D reconstruction of serial 
sections using TEM is generally considered to require extensive labor and time. On the other hand, even if the 
specimen is thicker in STEM than in TEM, it is possible to confi rm slice images, which is advantageous for 3D 
reconstructions by scanning the electron beam probe. In the present study, if it is possible to establish a method 
that evaluates reconstructions of serial sections of cells in elongated tissues, such as the vasculature, the same 
type of research may be effi ciently performed in the future.
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Materials and methods
Preparation of arterioles 
　　Experiments were conducted in a manner consistent with the guidelines of the Ethics Committee for animal 
treatment of Iwate Medical University. Adult male rats (Wistar, 8–12 weeks old, body weight 250–400 g, n=10) 
were used. Rats were killed by carbon dioxide gas followed by exsanguination. The testes were removed and 
soaked in 0.2 M phosphate buffer saline (PBS). Small arteries and venules were then isolated and digested with 
collagenase (100 U/ml; Elastin Products, Owensville, MO, USA) in the HR at 37°C for 40 min. Connective 
tissues were then carefully removed under the stereoscopic microscope.  

Fixation
　　The isolated arterioles and venules were observed by scanning transmission electron microscopy (STEM). 
Non-treated fresh arterioles and venules obtained from testes were fi xed in 25% glutaraldehyde (Nacalai Tesque) 
and 4% paraformaldehyde (Merck, Germany) in PBS (0.1 M) at room temperature for approximately 6 hrs. 
After washing 3 times using distilled water, the cells were postfi xed with 1% osmium tetroxide for an overnight 
incubation at room temperature, and then dehydrated in a series of ethanol and embedded in Epon 812 (TAAB, 
Berkshire, UK) for an overnight incubation at room temperature. Longitudinal sections were consecutively cut 
through the arterioles and venules using an ultramicrotome (ULTRACUT-UCD, Leica, Germany). Semithin 
sections (thickness of approximately 1 μm) were cut on an ultramicrotome using a Jumbo knife (Histo Jumbo, 
Nisshin EM, Tokyo), stained with toluidine blue, and observed by light microscopy. Ribbons of serial thin 
sections (thickness of between 70 and 100 nm) were retrieved on Indium-Tin-Oxide (ITO)-coated slides (Fig. 1) 
and doubly stained with uranyl acetate and lead citrate.  

Recording image data
　　The fi ne structures of the vessels were examined using a Field-Emission Scanning Electron Microscope 
(SU8010; Hitachi, Tokyo) at an accelerating voltage of 1.5 kV. Images were collected with dimensions of 
2560 × 1920 pixels with averages of quadruplicates, and were viewed and analyzed by Image Fiji software.

Fig. 1.  Ribbon-like serial sections (approximately 
100 nm) of testicular blood vessel specimens 
collected on a slide glass
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Image processing
　　Image Fiji is a well-known and long-lived open source software for biomedical image analyses (Schindelin 
2012). Multiple images taken using the tiling function for the scanning electron microscope of Image Fiji 
were automatically arranged to create a montage image (Ogura 2010). The image obtained by the scanning 
transmission electron microscope was reversed in contrast to the transmission electron microscope. In order 
to ensure that image quality was the same as that of a normal TEM image, image colors were inverted using 
Photoshop® (Adobe INC, CA, USA).

3D images
　　Before displaying 3D images, parameter settings in the Z axis direction of Image Fiji were performed. 
In the Image Fiji menu bar, [File] > [Import] > [Image Sequence] was selected. The sequence of images was 
loaded. [Analyze] > [Set Scale] was then opened. The Set Scale dialog was brought up, and the distance in 
pixels: 1, the known distance: 24.8, the unit of length: nm, and the scale: 0.0403 were entered (Fig. 2).

　　[Image] > [Properties] was opened and the numerical value of Voxel depth was entered. Since the input 
numerical value of the analysis this time was a section thickness of 100 nm, it was 100 (nm)/24.8 = 4.03 nm/
pixels. The thinning processing method was performed; therefore, twice the thickness was entered to 
24.8 × 4.03 × 2 = 199.888 in the voxel depth (Fig.3). By using this method, the setting was made taking into 
consideration the thin area of the blood vessels. By coloring smooth muscle cells using Photoshop beforehand, 
3D imaging was performed on the colored parts of cells using the TrakEM2 function of Image Fiji. Therefore, it 
was possible to clarify the whole picture of smooth muscle cells.

Fig. 2.  The Set Scale dialog on Image Fiji 
(https://fi ji.sc) software

Fig. 3.  The Properties dialog on Image Fiji (https://fi ji.sc) software
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Result
　　Using STEM, cross-sections of arterioles and venules with a diameter of approximately 50 μm were 
observed. Electron microscopy revealed that specimens maintained the typical structural integrity of testicular 
arterioles. In the case of arterioles, endothelial cells with clear nuclei were observed, and the cross-sectional 
shape of cells was cuboidal. The lumen of this arteriole was lined by 10 endothelial cells, which were closely 
attached to one another by junctions. Cytoplasmic protrusions of endothelial cells were observed on the luminal 
side. Since this arteriole was partly contracted, endothelial cell nuclei bulged into the lumen. A few lamellar 
layers of the basal lamina were interposed between the endothelium and smooth muscle layer. Smooth muscle 
cells in arterioles overlapped in 2 to 3 layers (Fig. 4). Smooth muscle cells formed a continuous layer, and 
the cytoplasm of the cells contained rich myofilaments. No significant ultrastructural damage (e.g. swollen 
mitochondria or the vacuolation of the sarco/endoplasmic reticulum) was detected. In longitudinal sections, 
smooth muscle cells continuously surrounded arterioles. Smooth muscle cells were uniformly spindle shaped, 
and most nuclei were elliptical in shape. Cell nuclei were oriented perpendicular to the longitudinal axis of a 
vessel; endothelial cell nuclei were parallel to the axis. Depending on the location of arterioles, the length of 
smooth muscle cells was similar to the transverse diameter of the blood vessel (Fig. 5).

Fig. 4.  Electron micrograph of a cross-section of 
testicular arterioles (E: endothelial cells, 
M: smooth muscle cells). The vessel is 
bounded by a single layer of endothelial 
cells. Arrows indicate the thickness of 
smooth muscle cells.

Fig. 5.  Electron micrograph of a longitudinal 
section of testicular arterioles (M: smooth 
muscle cells)
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　　On the other hand, the structure of the vascular layer, including endothelial cells and smooth muscle cells, 
was not clearly seen in the cross-section of the venules. Furthermore, the lumen of the vessels was irregularly 
shaped instead of being circular as seen in arterioles. Only a few endothelial cells were observed. The number 
of smooth muscle cells containing microfi laments of actin and myosin was smaller and sparser than in arterioles 
(Fig. 6). In longitudinal sections, few smooth muscle cells were observed in venules, and intercellular spaces 
were detected between smooth muscle cells. The nuclei of smooth muscle cells were parallel to the axis of the 
venule (Fig. 7). Comparisons of cross-sections and longitudinal sections revealed that arteriole smooth muscle 
cells had an elongated spindle shape, we were unable to determine the three-dimensional structure of the venular 
smooth muscle from our current fi ndings. By focusing on luminal volumes, the thickness of blood vessel walls 
was measured in cross-sections of arterioles and venules with the same diameters. Wall thickness was two-
fold greater in arterioles than in venules (arterioles, 17.45 ± 1.6 μm, and venules, 8.1 ± 1.82 μm (Mean ± SD)). 
Therefore, venules had markedly larger lumens and thinner walls than the corresponding arterioles.

Fig. 6.  Electron micrograph of a cross-section of 
testicular venules (E: endothelial cells, M: 
smooth muscle cells, R: red blood cell). 
Arrows indicate the thickness of smooth 
muscle cells.

Fig. 7.  Electron micrograph of a longitudinal 
section of testicular venules (M: smooth 
muscle cells)
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　　To date, few studies have examined the morphology of venules in detail. Therefore, we observed the 3D 
structures of venules using Image Fiji software. A morphology-based approach to venular smooth muscle cells 
was performed using Image Fiji software (orthogonal view), with a 3D analysis based on XYZ. The results 
obtained showed that the smooth muscle cell had a spindle shape that was close to a circle based on information 
obtained from the Z axis direction image from the side view and the XY plane image (Fig. 8). In another 
example of a smooth muscle cell in the same venule, the cell had a squat spindle shape in the lower XY plane 
image, which was slightly long laterally (Fig. 9).

Fig. 8.  An orthogonal view screen image of testicular venules on Image Fiji 1
　　   Red: smooth muscle cell, the images on the right: Z-axis direction surface from the side, 

lower image: XY plane images

Fig. 9.  An orthogonal view screen image of testicular venules on Image Fiji 2
　　   Red: smooth muscle cell, the images on the right: Z-axis direction surface from the side, 

lower image: XY plane images



－　8　－

Masato HIRAKAWA et al.122

　　A 3D construction of smooth muscle cells using the StackEM 2 function of Image Fiji was then performed. 
The smooth muscle cell shown in Fig. 8 had a short spindle shape with short protrusions. The nucleus was 
nearly in the center of the cytoplasm, but was atypical (Fig. 10). Furthermore, the results obtained confi rmed 
that triangular-like cells and spindle-shaped cells were present in close proximity (Fig. 11).

Discussion
　　Previous findings obtained from images using conventional SEM showed that the vascular walls of 
arterioles developed in transverse and longitudinal directions and arterioles were surrounded by spindle-shaped 
smooth muscle cells in a circular manner (Ushiwata and Ushiki 1990, Saino 2002a, 2002b, 2008, Tamagawa 
2009, 2013, Okubo 2016). However, few morphological studies have been conducted on venules using SEM 
(Murakami 1971, Hoshi 1999). Murakami introduced a technique to obtain resin replicas of the microvascular 
bed and evaluated microvascular corrosion casts by SEM (Murakami 1971). Since its development by 
Murakami, the corrosion cast method for scanning electron microscopy is now regarded one of the most effi cient 
means for clarifying the 3D features of the microcirculation of organs and tissues (Murakami 1971, Kohler 
1983, Motta 1992). However, few morphological studies have been conducted on venules using TEM (Beacham 
1976, Bizuneh 1991, Knop 2005). In contrast, smooth muscle cells were sparse in venules. Few vessels 
were identifi ed as vascular smooth muscle cells due to the presence of microfi laments, and it was diffi cult to 
observe the overall morphology of venules from cross-sectional images alone. Difficulties were associated 
with clarifying the whole form of venules based only on cross-sectional images. However, the present results 
showed that the form of smooth muscle cells in venules was completely different from that in arterioles, which 
have many projections with short spindles. The activity of smooth muscles allows lymph vessels to slowly 
pump lymph fl uid throughout the body independent of the heart. In contrast, smooth muscles in blood vessels 
are involved in vasoconstriction and vasodilation instead of fl uid pumping. Given the characteristic form of the 
venules, venular smooth muscles likely have a larger role as a reservoir for blood rather than in maintaining the 
blood pressure by contracting like arteriolar smooth muscle cells to adjust the blood fl ow. However, compare 
with the lymphatic vessels, smooth muscle in venules may be necessary to prevent collapse of the lumen. 
Venules have a typical and unique smooth muscle cell shape, which suggests that they are not simply inert 
drainage ducts. However, further research is needed to clarify the functions of venules.

　　In the present study, 3D reconstruction techniques using STEM enabled 3D image acquisition with a wide 
fi eld of view. This method appears to be useful for stereoscopically and minutely observing the shapes of some 

Fig. 10.  A 3D image on Image Fiji of testicular venous smooth 
muscle cell 1. Red: cytoplasm, blue: nucleus

Fig. 11.  A 3D image on Image Fiji of testicular venous smooth 
muscle cell 2. Red: cytoplasm, blue: nucleus
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tissues and a small number of undeveloped cells (Ponce 2012). 3D reconstruction techniques generally require 
time and effort; however, in STEM, it is relatively easier and more accurate to observe samples by considering 
the following points. Before maki ng serial sections, it is important to grasp the position and size of the target 
to be observed and estimate thickness and the number of slices. If the thickness of the vascular wall is not 
determined, the number of segments will not be sufficient for the purpose of observation. In the case of an 
excess number of slices, observations become ineffi cient. Furthermore, when making serial sections of samples, 
it is necessary to make many slices by reducing the vertical thickness of sample blocks. Many sample slices may 
be placed on the slide glass, and subsequent dying and the preparation of microscope slides for observations 
may be simplifi ed.

　　By performing the thinning process without photographing all serial slices at the time of observations, 
work effi ciency increases and the amount of 3D reconstruction data may be reduced. However, since the amount 
of thinning data increases, the depth data on the z-axis direction becomes indistinct. Therefore, a trade-off with 
the amount of work needs to be considered. It may also be advantageous to estimate the total amount of thinning 
out from serial slice numbers. In the present study, we thinned out one slice at a time with 100 pieces of serial 
slices and photographed 50 images. When the thinning process was performed, it was impossible to accurately 
construct a 3D structure unless we corrected parameters by Image Fiji before performing the 3D reconstruction 
method and adjusting for the subtracted values with numerical values.

　　In conclusion, by performing 3D reconstruction techniques based on STEM images obtained in a wide 
fi eld of view, it was possible to simultaneously compare multiple cells and elucidate the relationship between 
cells themselves and their intracellular structures. In the 3D reconstruction techniques used in the present study, 
3D images were easily obtained. Therefore, this 3D reconstruction method may stereoscopically reveal all cell 
and tissue structures irrespective of blood vessels only, and may markedly contribute to future functional and 
morphological studies on cells and tissues in the body.
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